An introduction to 3D draughting & solid modelling using AutoCAD

Faculty of Technology
University of Plymouth
Drake Circus
Plymouth
PL4 8AA

These notes are to be used in conjunction with the AutoCAD software help system.
Contents:

1 Introduction .................................................................................................................. 3
  1.1 Pre-requisites ...................................................................................................... 3
  1.2 About 3D and this 3D tutorial ........................................................................... 3

2 Drawing in 3D. ........................................................................................................... 4
  2.1 Introduction ........................................................................................................ 4
  2.2 Specifying a position in 3D space. .................................................................... 4
    2.2.1 Creating lines in 3D using coordinates ....................................................... 4
    2.2.2 Creating lines in 3D using object snap ....................................................... 5
  2.3 Specifying and using coordinate systems in 3D space ....................................... 5
    2.3.1 Using the UCS .......................................................................................... 6

3 Surfacing in 3D ......................................................................................................... 7
  3.1 Introduction ........................................................................................................ 7
  3.2 Creating basic surfaces ..................................................................................... 7
  3.3 Creating more complex surfaces .................................................................... 8

4 Solid modelling. ....................................................................................................... 10
  4.1 Introduction ..................................................................................................... 10
  4.2 Primitive solids ............................................................................................... 10
  4.3 Composite solids ............................................................................................ 10
  4.4 Extruded and revolved solids .......................................................................... 10

5 Design tools in ‘Architectural Desktop’ ................................................................. 12
  5.1 Accessing Tool Palettes/Design Tools ............................................................. 12
  5.2 Using the design tools ..................................................................................... 12
    5.2.1 Walls ..................................................................................................... 12
    5.2.2 Windows and doors .............................................................................. 13
    5.2.3 A roof ................................................................................................... 13
  5.3 Adding extra design tools from the Catalogue Library ..................................... 13
    5.3.1 Creating a new tool palette .................................................................... 13
    5.3.2 Adding a tool from the library ................................................................ 13
    5.3.3 Creating section views .......................................................................... 14

6 2D drawings of the 3D model ................................................................................... 15
  6.1 General views ................................................................................................. 15
1 Introduction.

1.1 Pre-requisites.

To benefit from this introduction to 3D draughting & modelling using AutoCAD, you must be familiar with basic 2D draughting operations such as:

- creating and modifying lines, arcs, polylines, etc.
- using layers
- navigating around the drawing in the screen display using zoom and pan

If you wish to revise your 2D skills, refer to the An introduction to 2D AutoCAD.

1.2 About 3D and this 3D tutorial.

This tutorial is intended to work as a student centered learning resource. It will introduce you to the basics of creating 3D models of your building designs using AutoCAD. Use the AutoCAD help menu system as required.

You will be familiar with working in 2D (two dimensions). As you may have already found, this can be quite limiting. You are representing 3D objects in a 2D format, which has then to be interpreted in order to visualise in 3D. Working with a 3D model has many advantages over 2D representations, including:

- Ease of visualising from any view point.
- Ease of creating 2D draughting views.
- Creation of photo-realistic images, animations and virtual reality presentations.
- Use of geometry for computational analysis, e.g. FEA.
- Use of geometry for CNC manufacturing processes.

3D CAD offers tools to work not only on a plane, along the x and y axes as with 2D CAD, but also in 3D space along the z axis, giving depth to the drawing. This tutorial will introduce you to the three primary types of 3D modelling:

- Wireframe
- Surface
- Solid
2 Drawing in 3D.

2.1 Introduction.

This section will provide a brief introduction to the 3D environment and to creating wireframe models in 3D.

2.2 Specifying a position in 3D space.

Drawing in 3D is essentially the same as drawing in 2D. The same commands work in the same way. The only difference is that you use the $z$ component in the Cartesian coordinate system along with the $x$ and $y$ components. So the origin would be:

$<0,0,0>$

In 2D CAD there is only one plane on which you create your drawing, so any ‘selecting click’ with the cursor or pointer will automatically pick off that plane. In 3D there are an infinite number of possible planes, so the situation becomes much more complicated.

The secret to easy and efficient modelling in 3D, whatever software you use, is how you use the tools available to specify a point or position in space when editing a 3D entity.

2.2.1 Creating lines in 3D using coordinates.

Start AutoCAD. Open a new file and set the following, with the commands:

- `units mm`
- `limits <0,0> to <400,400>`
- `snap 10`
- `grid 10`

Use the `line` command to draw lines to model the wireframe shape below, entering the coordinates on the command line.

This is a 3D wedge shape is made up of lines only.

You can create most entities in 3D, as in 2D, by specifying point positions required using **absolute** or **relative** coordinates.
2.2.2 Creating lines in 3D using object snap.

**Object snap** allows you to pick specific locations on existing geometry in 3D space.

Use the **osnap** command to examine and control the object snap set up.

Turn **snap** off, start drawing a new **line** and then move the pointer around the display. Observe how the pointer changes as it moves over or near particular snap locations on the model. Create more 3D lines on the wedge wireframe using midpoints, endpoints, etc. Experiment.

Practise by creating a wireframe cube of 200mm side and join all opposite corners up with diagonal lines.

Use the **copy** command to help draw parts of the cube!

![3D wireframe image]

---

2.3 Specifying and using coordinate systems in 3D space.

The **WCS**:

When you use the snap tool, the pointer jumps around on an invisible grid system, enabling you to quickly place the pointer precisely on points of that grid. (This jumping or snapping on the grid is set up using the **snap** command by the way.)

The ‘snap grid’ system lies on a flat surface defined in space by the current **coordinate system**. If you were to draw a circle it would also lie on this plane. If you were to create some hatching it would also lie on this plane. The primary coordinate system used to define this plane is called the **World Coordinate System**, or WCS, and its x and y axes define the plane itself. The WCS is the **absolute** reference AutoCAD coordinate system.

The **UCS**:

You can define your own coordinate systems, make them current and use them as aids to editing geometry, etc. These types of coordinate systems are called User Coordinate Systems, or **UCSs**.
2.3.1 Using the UCS.

To draw a circle on the ‘side’ of the wireframe cube above, you would start by creating a new user coordinate system (UCS) whose x and y axes lie on the plane of the relevant side.

One way of creating this new UCS to draw the circle is given below:

1) Create the UCS using the command line:

   **ucs** Starts up the UCS managing tools
   **n** Create a new UCS
   **3** Define the new UCS with 3 points (selected from existing geometry here.)

Follow the command line prompts to define the origin, x and y axes of the new UCS. Pick points from the existing geometry.

Once completed you should notice how the pointer crosshair orientation changes to align with the new UCS and the x, y and z axes have also reoriented.

2) Save the UCS using the command line:

   **ucs** Starts up the UCS managing tools
   **s** Saves the current UCS, you will need to name it.

You may also find the **ucsman** command useful. Check it out.

To practise, create and save (and name) three new UCSs, one for the side, one on the top and one on one of the internal triangles. Use each of these to draw a 2D shape on each ‘face’. UCS commands are also available under the **View** pull down menu.
3 Surfacing in 3D.

3.1 Introduction.

Now you can work with lines in 3D space the next step is to start creating and working with surfaces.

Surfaces, mathematically speaking, have no thickness. They do however have two sides (or faces) and they have edges (or boundaries), much like a sheet of paper or a piece of cloth does. They can be shaded and can be used to provide good visual representations of solid objects. Creation of surfaces can get very involved. You will be introduced here to some of the basic methods, using AutoCAD.

Search for surfaces in the help index of AutoCAD, then double click on creating for more information. Check out the procedures and references tabs as well.

3.2 Creating basic surfaces.

Surfaces, at least in terms of how 3D modelling packages work, fall into two main categories, the flat, planar ones and the freeform type, based on curves. Flat, or planar, surfaces are the simplest and easiest to work and are introduced in this section.

To start with, quickly create a 3D wireframe house like the one shown below. Create the wireframe lines on their own layer. Actual dimensions do not matter.

Use this wireframe model to experiment with creating flat surfaces using the 3dface command.

Create a surface on each flat section of the roof using the command:

3dface

The 3dface tool will create a triangular or flat quadrilateral surface from points specified by you. You can select the points on the display using the object snap facility or enter their absolute or relative coordinates.

To shade the model you can use the shade command. To hide geometry that is hidden by surfaces use the hide command.

Another method of creating 3D surfaces is with the elev command. This command effectively extrudes any 2D entity such as points, lines or circles to a height or thickness.
It can also offset the position of the entity by defining an elevation value. To get an idea of this follow this example:

From the command line:

```
elev
```

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>elev</code></td>
<td>Starts the elevation command.</td>
</tr>
<tr>
<td>default elevation</td>
<td>Sets the offset distance.</td>
</tr>
<tr>
<td>default thickness</td>
<td>Sets the extrusion length or thickness.</td>
</tr>
</tbody>
</table>

Now draw the following entities:

- **Line.**
- **Polygon.**
- **Circle.**
- **Rectangle.**
- **Polyline.**

...and then view them from an angle...

Note how each 2D shape has been extruded to the thickness value.

You will find that the thickness is actually one of the properties of the surface, and it can be edited. Try changing the thickness of one of the surfaces using the `properties` command.

### 3.3 Creating more complex surfaces.

There are tools within AutoCAD used for creating more complex 3D surfaces...

- **Edgesurf** Fills a closed quadrilateral. Surface can be planar or non-planar and sides can be lines, arcs or curves.

- **Revsurf** Creates a surface mesh from revolving a curve around an axis of revolution.
Rulesurf  Creates a mesh between two lines or curves. (surftab2 >2)

Tabsurf  Creates an extrusion of a curve, like the elev command, but is not restricted to perpendicular extrusion direction.

All of the above tools use the variables `surftab1` and `surftab2` to control the density of the resulting meshes. To set the values of these variables simply enter the variable name on the command line and then enter the new value.

Create the following surfaces using each of the tools specified. In each case use the AutoCAD help, referring to the command name.

Use the prepared file `surfaces_1.dwg`, which will give you the wire frames as shown above. Remember to create and use a new layer for the surfaces.
4 Solid modelling.

4.1 Introduction.

Solid modelling provides the same display information as surface and wireframe modelling. It also offers the advantage of representing the entire volume of the design. The model can therefore be analysed for volume related properties such as mass, moments of inertia, center of gravity, and the model data can be used for 3D CNC machine programming and 3D FEA. (Investigate what FEA is, perhaps using the internet.)

This section offers a very brief introduction into some of the solid modelling facilities in AutoCAD. You will need to use the AutoCAD help facility for this section.

4.2 Primitive solids.

In the help system, under the index tab, type 3d solids and then double click on creating in the resulting list.

There are basic primitive objects that can easily be created in AutoCAD. Read through the introduction and then follow the guidelines to create examples of the following primitive solid entities:

- Box
- Cone
- Cylinder
- Torus
- Wedge

4.3 Composite solids.

Primitive objects can be added together or subtracted to make more complex solid objects called composite objects. On the same help page as above follow the guidelines to create examples of composite objects made using union, subtract and interfere.

4.4 Extruded and revolved solids.

Experiment also with the extrude and revolve commands, as also described on the same help page as above.
As an exercise, try modelling a simple house using solids:

Draw a plan of the walls as a polyline.

You can draw the outline using the line command and then change the lines into a polyline using the `pedit` command.

The polylines can be extruded. Then you can model other solids and add, subtract or union them accordingly to sculpt the solid shape you desire. Use existing geometry to define new UCSs, etc.

Plan how you will form the sloping roof, using the subtract or slice command.
5  Design tools in ‘Architectural Desktop’.

If you are using the Architectural Desktop version of AutoCAD, you will have a host of architectural design tools available to you. These tools have been developed for building designers to quickly model all types of construction related objects such as walls, slabs, windows, doors, beams, etc. These objects are known as intelligent objects. They have a comprehensive range of parameters defining them. These parameters are accessible and editable through their Properties.

To find out more in general go to the Contents section of the help system and explore!

5.1  Accessing Tool Palettes/Design Tools.

Access to the design tools is gained either through the ‘Design Pull down’ menu or through the on screen ‘Tool Palettes’.

To display the Design pull down menu:

**Window > Pulldowns > Design Pulldown**

To display the ‘Tool Palettes’ window enter on the command line (…or click the appropriate toolbar button):

```
toolpalettes
```

Both of these are good to use. The Tool Palettes is particularly useful as you can add extra tools from the Catalogue Library, as you will see.

5.2  Using the design tools.

We will practice using some of these design tools by creating a wall, then adding windows, doors and a roof.

5.2.1  Walls.

In the Tool Palettes, click on the Walls tab. From the selection presented click on a wall of your choice. To create the wall, in the model space, click in two separate places to draw a horizontal line. Press Esc to end the command. 3D rotate or select an isometric view point to view the 3D object. You will see that you have created a single wall.

Double click the wall to open its Properties window. Notice that a layer has been automatically created for your new wall. You can also edit the dimensions of the wall. Observe the grab points on the wall, displayed in the model space. Drag these one at a time to observe how you can alter the various dimensions.

Note that the x y plane defines the plan, the plane that the wall is extended from perpendicularly.
5.2.2 Windows and doors.

In the Tool Palettes click on the Windows tab. From the selection presented click on a window of your choice. In the model space click on the wall and then click again to place the new window object. Press Esc to end the command. You will see that you have created a single window. 3D rotate or select an isometric view point to view the 3d object. Zoom in to look closely at how the window has been placed and how it has cut out the wall.

Double click the window to open its Properties window. Notice that a layer has been automatically created for your new window. You can also edit the dimensions of the window. Observe the grab points on the window, displayed in the model space. Drag these one at a time to observe how you can alter the various dimensions.

Repeat for a door object, from the Doors tab.

5.2.3 A roof.

Roofs appear under the Design tab in the Tool Palettes.

A roof object is, like the wall objects, created from the x y plane, so when you click in model space to define the roof you are clicking on the x y plane, not on top of the wall that the roof sits on. One of the roof parameters is the Plate Height, which is the height of the structure that the roof sits on.

To see how the roof tool works first draw a rectangle as a plan reference. Then create a roof object by clicking on Roof on the Design tab. Snap to and click on each of the four corners of the rectangle in turn and press return (enter).

Double click on the new roof and look at the Properties. Change the values of the parameters to see how they define the roof.

5.3 Adding extra design tools from the Catalogue Library.

Architectural Desktop comes with a large library of extra design tools. These can be selected from the Catalogue Library, added to your Tool Pallettes and then used in your model/drawing.

5.3.1 Creating a new tool palette.

First create a new Tool Palette tab. Right click in the title bar of the Tool Palettes window and click New Palette. Name it Sections.

5.3.2 Adding a tool from the library.

Display the Catalogue Library window by entering on the command line (…or click the appropriate toolbar button):

contentbrowser
It is worth looking through all of these at a later stage, but for now we will look at a tool from the **Documentation Tool Catalogue - Metric** which we can use to create section views for use in our 2D drawings.

So, click on the…

**Documentation Tool Catalogue - Metric**

In the left hand menu select **Callouts > Section Marks**

Right click the **Section Mark A1** and **Copy**. Then under the new **Sections** tab of the **Tool Palettes** right click and **Paste**.

**5.3.3 Creating section views.**

This **Section** tool enables us to create a 2D section view of any 3D solid object created in model space. The section view can then be presented in a layout drawing, as discussed in section 6.

The Section tool works particularly well with the design objects covered in this section.

In model space, first, to ensure that you are viewing in plan enter **plan** on the command line and press enter to accept the <Current> coordinate system.

You will now create a section view of the wall you have created in this tutorial.

Click the **Section A1** tool.

**Step 1:** Read prompt on command line.

Click two locations and then return ↵ (enter) to define a vertical line across the model plan view. This line defines the section cutting plane.

**Step 2:** Read prompt on command line.

**Drag out and click** a position over the side of the model that you wish to look towards in the section view.

**Step 3:** Read prompt on command line.

In the resulting **Callout Placement** window click the **Current Drawing** button and then click in the model space to place the 2D section view.

Double click on each text item to edit as you wish.
6  2D drawings of the 3D model.

6.1  General views.

If you wish to present your 3D design as a paper plot, you can do so using the same basic method way as described in the 2D tutorial, *An introduction to 2D AutoCAD*, section 6.

The secret is to control the scale of each viewport, so that there is consistency between orthographic views. You may also wish to put the viewport objects on to a new layer of their own, so that the boarder outline visibilities can be controlled easily when printing.

The drawing below shows standard orthographic projection views of the house created using a new viewport for each view, with each viewpoint set appropriately to give the correct image, using the standard AutoCAD 3D viewpoints, *View > 3D views*....

Each viewport can have its own display set up. The isometric view here is 'Flat shaded, edges on. The orthographic views above are ‘Hidden’.

Each viewport, seen here as the blue dashed boxes all selected together, has been put onto one layer, which can be turned off for plotting.

Dimensions should be added in paper space once the viewports have been set up and locked.